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The MediaCreator software is used with the MediaXtreme to create and display high-quality information display 

sequences.  The capabilities go far beyond that--sports score box overlays, text crawl overlays, Picture-in-Picture, 

and much, much more.   It’s the all-in-one answer for information display!  

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

MENUS 

 

MediaCreator Application  
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MediaCreator Menu Bar 

 

The menu bar (shown above) is just what you expect in a Windows program:  it has a File entry that is used to open, 
create, and save, the types of files that MediaCreator can open, create, and save (pages and projects).   

The Edit menu is used for the normal Undo, Cut, Copy, Paste, Insert, Delete, and Erase functions. 
The View menu is used to display or hide the various windows. 
The Attributes menu is used to adjust the various text attributes. 
The Move Text menu has commands for Word Wrap/Unwrap, Centering, Justifying, and Positioning.  It also has a 
command to let you adjust the Row Leading. 

The Settings menu is used to setup your system.  These include things like Setting User Preferences, Load 
Typefaces, Set Tabs, Adjust Safe title Margins, set the page to Lower Third mode, and setting your default 

folders/directories. 

The Preview menu is used for a Creation Station preview of your current project.  This preview will play on the 
computer you are using to create the pages.  It will not contain the dwell times or transitions that you have 

programmed.  Rest assured, those will appear on the MediaXtreme player just as you designed. 

 
The Communications menu item is the business end of the menu bar.  This is where you connect to the remote 
MediaXtreme player; send emergency messages, send schedules, send pages, and other maintenance functions.  This 

tab is covered in-depth in later pages. 

 
The Help Menu is currently not available.  For help, go to www.mediaxtreme.tv . 

TOOLBAR 

 
MediaCreator Toolbar 
The Toolbar (shown above) is a quick way to access common functions.  These include commands from the File 
menu such as Create New Page, Open Existing Page, and Save page.  Cut, copy, paste, and undo functions from the 

Edit menu are included on the toolbar. 
The toolbar contains a mode selection box that defaults to “Selected Text”.  This determines which text will be 
modified by a command such as select font.  The options include such things are Selected text, entire word, entire 
row, and entire page. 
To the right of the mode selection box are some buttons that Center and Justify the page. 
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XTREME PAGES MANAGER 

 
 

 

The Xtreme Pages Manager gives you quick access to all of the pages in your system.   

When a Page is saved, a thumbnail is created.   These thumbnails, along with the name of the page are displayed in 

the Xtreme Pages Manager.  To open a page, just click on its thumbnail. 

 

CREATOR WINDOW 
The Creator window is where you compose your pages.  To enter text in this window, point the mouse to where you 

want the text to appear, and click the left mouse button.  A rectangle appears where you clicked the mouse.  This is 

the text cursor.  It shows where text will be entered.  Type some text and it will appear at the cursor position.  This 

window is also where you will import your backgrounds, other graphics, and images.  This is the window in which 

you’ll make your information display come to life. 
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SHORTCUT BUTTONS 
The Shortcut Buttons window contains buttons of frequently used functions.  They are placed in this handy position 

so that you can just reach over and easily press one of these buttons with the mouse. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PRESET STYLE GALLERY 
MediaCreator can display up to 64 preset text styles.  These are text styles that will probably be used frequently.  

You’re not limited to only these 64 styles, they are only there as shortcut to the styles that you use most often.  You 

can scroll through the preset text styles, and select one by clicking on it.  When you select a new style from the Style 

Gallery, all selected text will be set to the new style.  After the new preset text style has been selected, any new text 

that you enter will appear in the selected text style.  You can change these preset text styles to be whatever you want 

by right clicking on one and selecting “set style”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



MX Series                                                     Media Creator 

 

 

Keywest Technology 
14563 W. 96th Terrace 

Lenexa, Kansas  66215    

800.331.2019 

www.keywesttechnology.com 

8 

 

 

CONTROL TABS 
MediaCreator text settings controls are numerous, and are divided into groups.  These are on a single Tab form.  

Simply select the appropriate tab for whatever adjustment you need to make.  

 

 
 
This tab lets you change the Height, Width, Italics, and Typeface of the character.  It is also used to select the Type, 

Depth, Direction, and Blur of the Edge.  The text size and position can also be changed by clicking and dragging the 

cursor handles.  You can turn the handles on and off.   

  

The Edge can be any of the following types:  

• No Edge 
The edge does not appear.  

• Full Surround 
The edge surrounds the character equally on all sides.  

• Extruded 
The character is extruded to give the character a 3D look.  

• Highlighted 
The character is extruded with a narrow full surround border to highlight the character.  

• Offset 
The edge is offset as if it is casting a shadow.  

The depth and blur of the edge of each character can be set separately.  If the selected edge type is Extruded, 

Highlighted, or Offset, the direction can be set to any of the 8 directions.  

Clicking on the “Depth” icon and dragging the mouse will change the edge depth. Clicking on the “Blur” icon and 
dragging the mouse will change the edge blur.  The text will be redrawn with the new values as you drag the mouse.  

 

Colors Tab 
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The Colors tab lets you change the color of the Character, the Edge, and Shadows. On the left there is a group of 

boxes that display the current color of each component of the character.  The box below it shows the color of the 

current component.  

To change the color, select the component to change (Character, Edge, or Shadow) then use the controls on the 

right to select the color.  There are five ways to select a color.  You can use a color picker, color sliders, select a 

color from a preset palette, set the color to a gradient, or set the color to a texture.  

Select one of the 5 buttons to choose which method to select the color.  

Here are the different methods you can use to select colors: 

• Color Picker 

• Color Sliders 

• Color Palette 

• Color Gradients 

• Textures 

 

Color Picker  

 
 
The color picker lets you select a color using a visual approach.  You can set the top and bottom colors separately.  

If the top and bottom colors are different, the Character, Edge, or Shadow will be drawn with a smooth color spread 

between the top and bottom.  One of the controls in this box is used to select the Hue (red, yellow, green, blue, etc) 

of the color.  When a new hue is selected the other color box will change to reflect the new hue. You can select any 

color from this box just by clicking the mouse on the desired color.  

You can also vary the Transparency and the amount of External video levels that the text component will be drawn 

with.  Transparency will let whatever is behind the component to show through.  Setting the Video Level draws the 

component with a mixture of background video and a color.  The higher the video level, the more dominant the 

background video will appear.  

The “Illegal Color Indicator” will appear red if the selected color is an illegal NTSC or PAL color.  It will appear 

green if a legal color is selected.  

 

Sliders  
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The color sliders let you select the color using a numerical approach.  You can choose whether you want to define 

RGB (red, green, blue) values or HLS (Hue, Luma, Saturation) values.  The top and bottom colors can be set 

separately.  If the top and bottom colors are different, the Character, Edge, or Shadow will be drawn with a smooth 

color spread between them.  

You can also vary the Transparency and the amount of External video levels that the text component will be drawn 

with.  Transparency will let whatever is behind the component show through.  Setting the Video Level draws the 

component with a mixture of background video and a color.  The higher the video level, the more dominant the 

background video will appear.  

The “Illegal Color Indicator” will appear red if the selected color is an illegal NTSC or PAL color. It will appear 

green if a legal color is selected.  

Palette  

 
 
You can select any of the 64 preset colors from the color Palette.  The top and bottom colors can be set separately.  

If the top and bottom colors are different, the Character, Edge, or Shadow will be drawn with a smooth color spread 

between them.  

The “Illegal Color Indicator” will appear red if the selected color is an illegal NTSC or PAL color.  It will appear 

green if a legal color is selected.  

You can also select Background Video as the color just by pressing the “Background Video” button.  To modify the 

color palette, double click on the entry that you want to modify.  The Color Palette Editor will appear.  This lets you 

change the color of each palette entry.  

Gradients  

 
 
Each project in the MediaCreator can have as many as 64 preset color gradients defined. They can be either linear 

gradients or area gradients.  A Linear Gradient can have up to 16 color points and can be rotated up to 90 degrees 

in either direction.  An area gradient can set each corner to a different color and the colors will create a smooth 

blend between the colors.  A center color point can also be added to create a 5-point color gradient.  The center 

point can be positioned anywhere within the color gradient.  This is very useful for creating highlighted colors.  

You can modify a color gradient by double clicking on the one you want to modify.  The Color Gradient Builder will 

then appear.  The Color Gradient Builder can then be used to select the type of gradient, as well as the color and 

position of the points in the gradient.  
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Textures 

 
 
The Textures button lets you apply a texture to any of the text components (Character, Edges, or Shadows).  Select 

any of the loaded textures by clicking the mouse on the desired texture.  There can be up to 8 textures loaded for 

each page.  Any JPG, GIF, TIF, TGA, BMP, or PCX image can be used as a texture.  To load a new texture, double 

click on the position that you want to load it into, and then select the image that you want to load as the new texture.  

 

 

Positioning Tab 
 

 
 
The Positioning tab has the buttons that are used to Wrap and Unwrap words, Centering, and Justifying rows, 

entire layers, and entire pages.  The text can also be fine positioned by using “Fine Positioning” buttons.  
The text can also be positioned by dragging the Movement cursor handles with the mouse.  

 
 

Row Spacing Tab 
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These controls are used to change the row leading (spacing) of the cursor row or the Entire page.  

 

Background - Colors Tab 
 

 
 
Background color boxes can be added to the page.  You can apply a solid color (with Transparency and 

Background Video) or you can apply a color gradient (linear, 4 point, or 5 point).  You can even apply a texture to a 

background color box.  

As many as 32 color boxes can be placed on each screen.  The layering order of background color boxes can be 

changed.  

 

Background - Image Tab 
 

 
 
A JPG, GIF, TIF, TGA, BMP, or PCX image can be loaded as a background Graphic.  When a background graphic 

is loaded, it will be displayed centered on the screen. 

 

Graphic-Full Screen will automatically size your image to fit the editor window.  Graphic-Original Size will 

maintain the actual pixel image size.  Graphic-Tiled will maintain the original image size but will tile the image to 

fill the entire editor window.  

 

If you select the “No Graphic” button, no background graphic will appear. 

Video Window Tab 
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This tab allows you to select a background source of video, or a scalable video window.    Scalable video window 

gives you a box on the Creator window, that you resize according to where and how large you want your video to 

play.  This automatically sets the integrated Picture-in-Picture board to display scaled video as you’ve commanded. 

 

 

 

 

Video Edge Color Tab 

 

 

 
 

 

 

 

 

 

 

 

 

If you’ve purchased the PiP option, and you’ve made a page with a PiP window, you can access the Video Edge 

Color tab and border your video image with colors, textures (pictures), or gradients just like a normal color box.  

On the Video Window Edge Color tab, you select your edge color or effect. 

 

Next, select your Video Window Tab again, and you can adjust the size and further effects of the video edge. 
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For our example above, in the previous illustration, we’ve used a texture to border the video window.  Notice the 

controls under the Video Window Tab that are copies of the Text shadowing controls.  We do this for familiarity—

the shadowing functions for the video window just as it does for text.  You can size it with the Depth function, Blur 

the border, change the type and angle of the shadow (or, if you prefer, the edge color).  Experiment with it and see 

what you can do!  Note:  The black box that represents the video feed area of the screen will not appear on the 

actual player—Live Video will fill that space—if there is no Picture-in-Picture option installed, you will only see the 

Video Border or nothing at all if no border selected. 

 

 

Picture Box 

The Picture Box tab will allow you to include images other than a background image within your 

page.  These can be any image of the same format used for background images. 

 

 
 

From here, you can click on ADD NEW PICTURE.  A browser window will open allowing you to select the image 

you wish to include in the page.  Once you’ve selected one (and it can be a tiny image or a full screen picture if you 

like—size and position is under your control). 
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To change size or other attributes of the picture box, you must access the TEXT tab, and turn on CURSOR 

HANDLES to click and drag resize.  You can also use the text size and width text boxes to change the picture box 

size. 

 

 

 

 

 

You may also use picture boxes in your crawls.  Simply drag and drop as you would on a normal page!  Use this 

capability for professional broadcast news appearance in your crawls as shown below. 

 

 
 

 

STATUS BAR 

 

 
 
The Status Bar (shown above) at the bottom of the screen displays the current status of the program.  It is divided 

into 4 panes.  The first pane displays a one line HINT about the Toolbar button or Menu entry that the cursor is 

currently pointing to.  The next pane shows the name of the current layer.  “Text” is the only layer available in the 

MediaXtreme.  The third pane shows the current typing mode (insert or overwrite).  The last pane displays the 

current row and column position of the cursor within the page.  

 

 

Xtreme Pages Manager 
The Xtreme Pages Manager is used to give you quick access to all the pages in your system.  This window (shown 
below) is on the left hand side of the screen. 
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All of the pages in the current project are displayed in this window.  The pages are represented both by thumbnails 

and names of the pages.   With the thumbnail, you can tell at a glance what the page looks like.  You can open any 

page in the project just by clicking on it in the Xtreme Pages Manager window.  If there are many pages in your 
system, you can scroll through the list of pages using the Page Manager scroll bar. 

 

Pages 
When pages are saved on the disk, they are each saved in a separate file.  The sizes of these files are determined by 

the amount of text and the complexity of the page.  Most pages are can be 1 or 2 Kbytes unless they contain logos, 

textures or complex graphics.  Storage space is completely dependent upon free disk space in your system.  Each 

page file must be given a unique name. 

 

The pages are stored in a format that allows them to be fully edited, even after they are saved.  You don’t need to 

worry about things getting “locked down” after the page has been saved.  All information needed to display the 

page is stored in the page file except for the Typefaces and the background graphic.  When a page has a Logo or 

multiple Logos on it, the logo is stored in the page file.  This is done to speed up the Page Recall time.  The page file 

does keep track of which background graphic and typefaces are used in the page.  When a page is recalled, the 

system will automatically load the needed typefaces and the background image. When a page is saved or recalled, 

the dialog box first displays with the default page directory.  You can select another directory to save the page to or 

recall it from.  The default page directory can be changed.  See the section “Default Directories” in Chapter 10 for 
more information on how to do this. 

Creating a New Page 
To create a new page, use one of the following commands: 

Press the “New Page” button on the Toolbar. 
Select the “New Page” entry from the “File” menu. 

Select the “New Crawl Page” entry from the “File” menu. 

Press and hold down the <Ctrl> key while pressing the <N> key. 
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When this is done the process of creating a new page will begin.  If the “Automatically Save Pages” setting in the 

“User Preferences” dialog box requires it, the following message box will appear. 

 

 
 

 
The system can only have one page opened at a time.  When you open a new page, the old page (or any changes 

made to it) will be discarded unless it is saved to the disk.  If you want to save the changes to the old, page press 

<Yes>, otherwise press <No> and the changes will be discarded. 
If the page was not saved, the following warning will appear: 

 

 
 
If you do not want to lose the changes to the current page, press the “No” button to cancel the New Page operation.  
You can then save the old page. 

 

Opening an Existing Page 
Opening a new page will overwrite the currently open page.  Make sure that you save any changes to the current 

page before opening a new one. 

 

To open an existing page, use one of the following commands: 

 

Select it from the listed pages in the Xtreme Pages Manager window. 

Select the “Open Page” entry from the “File” menu. 

Press the “Open Page” button in the Toolbar. 
Press and hold down the <Ctrl> key while pressing the <O> key. 
 
If the “Automatically Save Pages” setting in the “User Preferences” dialog box is set, the following 
message box will appear. 
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You can only have one page opened at a time.  When you open a new page, the old page (or any changes made to it) 

will be discarded unless it is saved to the disk.  If you want to save the changes to the old page press “Yes”, 
otherwise press “No” and the changes will be discarded. 
 

 

Once this is done the Open Page dialog box (shown below) will appear. 

 

 
Open Page dialog box 
Use this dialog box to select which page to open.  Once a page is opened it will appear in the Creator window.  You 

can now edit the page. 

Saving a Page 
When you are finished editing a page, you need to save it to the disk.  Select the “SAVE” or “Save Page As” entry 
from the “File” menu.  If the page does not yet have a name, the Save Page As dialog box will appear (see Saving a 
Page with a New Name) so that you can name the page. 

 

Often, while editing a page, you should save it to protect your work from things like power failures.  This function 

can be accomplished by holding down the <Ctrl> key and pressing <S>. 
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CREATING CRAWLS 
 

Crawls are created as separate crawl pages but are edited and saved 

just as regular pages.   

Crawls have text, font and formatting attributes of their own, in addition 

to crawl attributes that define their speed and how many times they will 

run.  There is one crawl position at the bottom of the screen and it can’t 

be changed.  As with any page in the system, a crawl page must be 

placed in a folder to be included in the schedule.  They are placed in 

folders that are defined specifically as Crawl Folders.  When Crawl 

Folders are placed in the schedule, they are defined as Crawl Events.   

 

Crawl Events run as separate events in the schedule and appear over all 

currently playing pages. 

 

To Create a Crawl: 

1. Select the File menu from the menu bar.   

 

The File drop down menu appears.   

 

2. Select New from the drop down menu and Crawl from the popup side menu.   
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3. Type the crawl message.  Note that your crawl text will not wrap down the screen.  It will be 

one continual line, just as the crawl will appear on your final output. 

 

4. Format the text with the same functions used in standard page creation.   

 

5. Assign crawl attributes with the same attributes keystrokes used for any page  

The Crawl Attributes window opens.   

 

***CRAWL SPEED AND TIMES TO CRAWL ARE NOT USED IN THE MX 

SYSTEM*** 

 

 

 

 

 

 

 

 

 

 

 

 

Create New Page 
Create a new page by selecting the “New Page” command from the “File” menu. This could also be done by 
pressing the first button on the Toolbar.  If you have modified text on the current page (and “Always Ask First” is 

selected under “Automatically Save Pages” in the “User Preferences”), a window like the one below will appear. 
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This reminds you to save any changes to the page before you create the new page.  Once you have selected “Yes” or 
“No”, a warning message (shown below) will appear warning you that the current page is about to be erased.  

 

 
 
If you press the “No” button the “New Page” command will be canceled.  If you press the “Yes” button the page 

will be erased.  This will create a new page that is blank. 

Creator Window 
The Creator window is where you compose your pages.  This window displays the text graphics, background image, 

and effects that you are working on as you compose them.   

Typing Text 
To enter text in this window, point the mouse to where you want the text to appear, and press the left button.  A 

rectangle appears where you clicked the mouse.  This is the text cursor.  It shows where text will be entered.  Now 

type any test message; the text will appear on your computer screen as you type it.   

 

If the text is too big to fit on the screen, simply size it down with either the cursor handles or the font size text box 

found on the tabs section of the program.  

Moving the Cursor 
You can use the cursor movement keys to move the cursor around in this window, or you can use the mouse to point 

to where you want the cursor to be placed and click the left button.  The Arrow keys move the cursor one character 

or row in the direction of the arrow.  The <Home> key moves the cursor to the beginning of the row if it’s not 
already there.  If the cursor is at the beginning of the row and you press the <Home> key, it will move to the 
beginning of the page.  The <End> key moves the cursor to the end of the row if it’s not already there.  If the cursor 
is already at the end of the row, it will move to the end of the page. 

Editing Text 
Move the mouse over the letter in your text, and press down the left button on the mouse. While holding down the 

Left button, drag the mouse to the left or right on your test text.  Notice how the cursor expands to cover more text. 
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Any operations done to the text, will be done to the text that is selected. Press the <Del> key.  The text that was 
selected was deleted.  To get this text back, hold down the <Ctrl> key and press the <Z> key (you could also press 
the UNDO button in the toolbar).  The last operation (delete in this case) is undone.  The MediaCreator will let you 
UNDO as many as 1000 operations—dependent upon the amount of RAM you posses and the speed of your 

computer. 

 

Move the cursor to another letter in your test text.   Hold down the <Shift> key and press the <Enter> key.  This 
splits the row into two rows.  A new row is created under the current row and the character that the cursor is on, 

and all characters after it, are moved down to the new row. 

 

Press the <Enter> key to move the cursor to the beginning of the next row. Hold down the <Shift> key and press 
the <Ins> key.  This inserts a new row at the cursor position. Now type another test text line.  Let’s delete this new 
row.  We could use the UNDO function, but let’s use the delete row function instead.  Hold down the <Shift> key 
and press the <Del> key.  The cursor row is deleted and all rows underneath it move up to take its place. 
 

Move the cursor to a first letter of any word in your test text.  Delete this word by holding down the <Ctrl> key 
while pressing <Del>.   The entire word is deleted and all text to the right of it moves over to fill in the space.  You 
can also type over text by running in the Overwrite mode, and you can insert text by typing in the insert mode.  

 

The functions that you just learned (as well as others) can also be invoked by using the commands in the “Edit” 
menu.  This menu also shows the keyboard short cut keys for these commands in case you forget them. 

Saving the Page 
Before we go through the “Erase Text” functions, let’s save the page so we can use it later.  Select the “Save 
Page” command from the “File” menu, or press the Third button (with the floppy disk icon) in the Toolbar.  Since 
this page has not yet been named, you will be prompted to enter a name for it.  Once the name has been entered 

(Let’s call it FIRST) press the “Save” button and the page will be saved to the current project.  Notice that a small 
thumbnail of the page appears in the Project Manager window along with the name of the page. 

 

Ensure you save the page with a name that consists of 8-characters or less, and contains only letters and numbers 

(no spaces or symbols).  Failure to follow this protocol will render your page useless. 

Erasing Text 
 
The “Edit” menu has commands for erasing text.  You can erase text from the cursor position to the end of the row, 
from the cursor position to the end of the page, or all of the text on the page. 

 

Move the cursor to a letter in your test text, then go to the “Erase Text” entry in the “Edit” menu and select “to 
End of Row” command.  Notice that all of the text from the cursor position to the end of the row is erased. 
 

Select the “to End of Page” command and all of the text from the cursor position to the end of the page is erased. 
Select the “Entire Page” command, and all of the text on the page is erased. 

Backspace 
If you make a mistake while typing (such as typing the wrong character) just press the <Backspace> key.  This will 

move the cursor to the previous position and erase the character there.  If the system is in Insert mode, the character 

will be deleted.  You can then type the correct character. 

Using Tabs 
The MediaCreator allows you to set up to 16 tabs per page.  These tabs specify horizontal positions on the screen. 

Columnar text can be aligned to the tabs.  If the Tab Display is enabled, the tab positions appear as vertical lines 

the entire height of the screen.   
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The tabs behave differently depending on the typing mode.  In the Insert mode, pressing the <Tab> key will insert a 

tab character at the cursor position.  All text to the right of the new tab will be moved to the next tab position.  

Pressing the <Tab> key in the Overwrite typing mode will move the cursor to the character at the next tab position.  

If no tab is set to the right of the cursor, the cursor will move to the beginning of the next row. 

The width of the Tab character is automatically adjusted so that the next character is placed at the next tab position.  

If no tab is set to the right of the tab character, it is treated the same as a space.  Changing the text to the left of the 

tab character (by entering more text or changing the size of the text) will not move the text that you have placed at 

the next tab position unless the text becomes too big to fit in the allotted space. 

 

Normal typing will not overwrite a Tab character (even in the Overwrite typing mode).  Any text that is entered 

before the tab will be inserted at the cursor position and the width of the tab will be adjusted to keep the text at the 

next tab position from moving.  To get rid of a Tab character, use the <Backspace> or <Del> key. 

 

The tab positions are stored with the page.  When a page is recalled from the disk, the tab positions that the page 

was created with are loaded with it. 

 

For more information on default set tabs, setting tabs, deleting tabs, and tab display see the section titled “Setting 
Up Tabs” in chapter 8. 

Row Space Allocation 
As text is entered, sized, and repositioned, rows of text may begin to overlap each other, or may appear with too 

much spacing between them.  To set the Row spacing back to what it should be (based on the text on the row), press 

the “Reset Row Spacing” button in the shortcuts window to reset the height of every row of the page. 

Cursor Movements 
The cursor movement keys allow you to move the cursor around the screen.  The cursor can also be positioned with 

the mouse. 

Cursor Up 
The <↑> key moves the cursor up one row unless it is already on the top row of the page.   

Cursor Down 

The <↓> key moves the cursor down one row.   

 

Cursor Left 
The <←> key moves the cursor left one character position.  If the cursor is at the left margin, the cursor will move 

to the end of the next row up (provided it’s not already on the top row). 

Cursor Right 
The <→> key moves the cursor right one character position.  If this moves the cursor beyond the end of the row, the 

cursor will move to the beginning of the next row. 

Home 
Press the <Home> key to move the cursor to the first character of the row.  If the cursor is already on the first 

character of the row, pressing the <Home> key will move the cursor to the first character position of the first row of 

the page.   

End 
Press the <End> key to move the cursor to the last character of the row.  If the cursor is already on the last 

character of the row, pressing the <End> key will move the cursor to the last character of the page 

Page Up 
Pressing the <Page Up> key will move the cursor to the last character on the screen. 

Page Down 
Pressing the <Page Down> key will move the cursor to the home position screen.  
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Setting Cursor Position with the Mouse 
The cursor can be moved with the mouse.  Move the mouse pointer to the desired position and click the left button.  

The cursor will move to the character being pointed to.  If characters are overlapped, continue to click the left 

button until the desired character is selected. 

 

VARIABLES (AKA TOKENS) 

 

Variables, the feature formerly known as Tokens, are the MediaXtreme’s way of displaying dynamic data on pages 

and in crawls.  They can be used to add time, date, temperature, wind speed, and more to your pages.  They can also 

be used for real-time data services.  Variables work just as their name indicates.  Placing them on the screen will 

hold a spot for actual data at “run” time…when your pages are playing live.   

 

All systems are capable of utilizing time and date variables.  Other variables are dependent upon options you have 

purchased for your unit.  This could include AP® Newswire service, Weather services, Sports services, Data 

services and more. 

 

Click on TEXT SUBSTITUTION tab.   

  

 
 

 
Now, click on the ADD NEW VARIABLES button.  You will see all available variables for selection. 

 

Clicking on a Variable will make it appear on your page where your cursor is currently 

positioned. 
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Available Standard Variables included with your MediaCreator and MediaXtreme are as follows: 

 

  12 Hour = numeric hour based on 12 Hour Clock (ex. 9) 

  24 Hour = numeric hour based on 24 Hour Clock (ex. 21) 

  Day of Month = current day of month (ex. 18) 

  Full Date (MM/DD/YYYY) = ex. 12/28/2002 

  Full Year (2003) = ex. 2003 

  Long 12 Hour Clock  =  ex. 9:12:33 PM 

  Long 24 Hour Clock = ex. 21:12:33 

  Long Day of Week (Tuesday) = ex. Tuesday 

  Minutes = numeric minutes based on current time (ex. 12) 

  Month (Aug) = Abbreviated Month (ex. Aug) 

  Month (August) = Month Name (ex. August) 

  Month Number = Month Number (ex. 8) 

  Seconds = numeric seconds based on current time (ex. 33) 

  Short 12 Hour Clock =  ex. 9:12 PM 

  Short 24 Hour Clock = ex.  21:12 

  Short Day of Week (Tue) = Abbreviated name of weekday (ex. Tue) 
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  Short Year (03) = Last two digits of current year (ex. 03) 

 

The other standard variables listed in the tab consist of Rainwise weather instruments variables.  

They are only functional if you own a WS-1000 or WS-2000 Rainwise Weather Station.  Contact 

your sales representative for further details. 

 

DISPLAYING WEATHER INFORMATION - THE WEATHER 

STATION OPTION 
The optional Weather Station package enables current live weather information to be included on pages displayed 

by MediaXtreme   

Weather Station Installation 
The Weather Station should be installed before the MediaXtreme is turned on.   

To Install the Weather Station: 
1. Assemble the Weather Station as per documentation included with it.    

2. Find the nine-pin serial cable enclosed with the unit.   
3. Connect the cable end labeled PC to the appropriate serial connector on the back of the 

MediaXtreme and the other end to the Weather Station serial connection.  

4. Insert the power cord in the Weather Station, plug into a power source and power on the unit.   

5. Power on your MediaXtreme.  

 

Displaying Weather Information on a Page 
Weather information generated by the Weather Station remote unit can be displayed on any page through the use of 

Variables.  Typically displayed weather information includes outside temperature, rainfall, barometer readings and 

wind speed.  When a page is created that will have weather information included on it,  variables are placed on the 

page in the exact location where the desired information should appear.  The actual weather information will not be 

seen on the MediaCreator screen when creating or editing the page. (The Preview Page function also shows just 

Variables.)   When the page with the Variables is run in the schedule and displayed by the display unit, the weather 

information defined by the Variables will be on the page in place of the variable.   

 

Spacing and additional characters are used when creating the Multiple variables can be placed on a page as 

required.  Use readability and a sense of page design as guides for a practical limit.   

 

Rainwise Weather Readings Include: 

 

Inside Temperature 

Outside Temperature 

Max Outside Temp 

Max Outside Temp Time 

Min Outside Temp 

Min Outside Temp Time 

Inside Temp in Celsius 

Outside Temp in Celsius 

Max Outside Temp in Celsius 

Min Outside Temp in Celsius 

Barometer 
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Max Barometer 

Max Barometer Time 

Min Barometer 

Min Barometer Time 

Barometer in mmHg 

Max Barometer in mmHg 

Min Barometer in mmHg 

Wind Direction 

Wind Speed in mph 

Max Wind Speed 

Wind Speed in kph 

Wind Speed max in kph 

Max Wind Speed Time 

Wind Chill 

Min Wind Chill 

Min Wind Chill Time 

Rainfall 

Rainfall Accumulation 

Humidity 

Heating Days 

Cooling Days 

ADDITIONAL SYSTEM FUNCTIONS 

Maintenance: Deleting Schedules, Folders, Pages and 

Crawls, Backgrounds and Sound Clips 
The Maintenance functions are found in the File menu.  They allow various system elements to 

be deleted.   

 

Caution should be taken when deleting anything from the system.  And, of course, the system 

will prompt for confirmation before it will allow anything to be deleted.   
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When a selection is made, a window will appear listing all the elements of the type selected, such 

as schedules or folders.  Choose the element from the list that must be deleted and click Delete.   

 

NOTE: Deleting a schedule assigned to a Remote Location not only removes all schedule 

information, but removes the definition of that Remote Location from the system 

as well.  If that was the only Remote Location the system had, a new Remote 

Location would have to be defined for any displaying of pages to be done. 

 

Chapter 4 

Text Styles 

 
MediaCreator gives you a surprising amount of control over the text style.  The text is made up of the two different 

components.  These are the character and the edge. 

You can select any true-type font for the character (either already on your computer, or imported from elsewhere).  

You control the Height, Width, Italics, and the Color of the character.  For the edge you can select the Edge Type, 

Direction, Depth, Blur and the Color. 

Many of the text style attributes (height and width for example) are represented numerically.  These numerical 

attributes can be modified by controls that are either absolute or relative.  An absolute control will set all of the 

selected text to the new value. A relative control will change all of the selected text by the same amount. 

To illustrate the difference between absolute and relative, let’s assume there is a word on the screen.  The first 

character of the word is 50 scan lines.  The rest of the word is 25 scan lines high.  If you select the entire word and 

use a relative control to increase the height of the first character by 25 scan lines to 75 scan lines, the height of the 

rest of the word will be increased by 25 scan lines to 50 scan lines. 

If you use an absolute control to set the height of the first character to 60 scan lines, the  height of the entire word 

will be set to 60 scan lines (they won’t maintain their height relative to each other). 

Text Styles 
To change the text style, select the Text Tab in the Control Tab Window.  The controls for adjusting the text style 
will be displayed as shown below. 
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This control tab window has 4 groups of controls to control numerical text attributes. There are controls used to 

select the Edge Type and direction.  It also has a Cursor Handle Button to turn the cursor handles on and off, a 

selection box that lets you change the Typeface, and a button you can press when you want to Italicize the text.  It 

even has a button that you can press when you want to load new Typefaces. 

The numerical control groups are: 

• Height 

• Width 

• Edge Depth 

• Edge Blur 

 
Each group of numerical controls is made up of 4 controls.  The top control in the group (the one with the icon) is a 

drag button.  The drag button is the relative control of the group.  To use the drag button, move the mouse over it, 

press the left mouse button, and drag the mouse.  Moving the mouse up or to the right will increase the value.  

Moving the mouse down or to the left will decrease the value.  The other three controls in the group are the absolute 

controls. 

The absolute controls consist of a number box and two small buttons to the right of it for  increasing and decreasing 

the value.  The value in the number box can be entered directly by moving the mouse over the number, double 

clicking the mouse (this will highlight all of the digits in the number), and entering the new value.  The value can be 

increased by pressing the increase button to  the right of the value.  If you hold this button down the value will 

continue to increase until you release the button.  To decrease the value, press the decrease button.  Holding down 

this button will continue to decrease the value until you release it.   

If you move the mouse over the number, then press and hold down the left mouse button, you can change the value 

by moving the mouse.  Moving the mouse up or to the right will increase the value.  Moving the mouse down or to 

the left will decrease the value.  When you have the desired value, release the left mouse button. 

The Cursor Handle Button allows you to turn the cursor handles on and off. 
The Typeface selection box lets you select a different Typeface.  This is used to select from any of the 10 typefaces 

that are currently loaded. 

Let’s explore these buttons a little closer.  Create a new page by pressing the New Page icon in the toolbar.  From 
the style gallery select a reasonably sized text style.  Then type the word “TEST” in all capital letters.  Press the 
<Home> key to move the cursor to the first “T” in the word “TEST”. 
Move the cursor over to the Height Drag Button, press and hold down the left mouse button and move the mouse up.  

Notice that the size of the character increases.  Release the left mouse button. 

 

Drag the mouse across the entire word to select it.  Move the mouse over the Height Drag Button, press and hold 

down the left mouse button, and move the mouse down.  Notice that the height of every character in the word 

decreases by the same amount.  The value of the number box is changed to display the current height of the first 

character that is selected.  

Now let’s see how the absolute controls behave differently.  Move the mouse to the height number box and double-

click it.  This will highlight all of the digits.  Re-enter the digits exactly as they were before (if they were originally 

48, enter 48) and press the <Enter> key.  Notice that all of the characters became the same size as the first 
character, they did not maintain their relative character heights. 
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The height of the characters can be varied and set to any size between 10 and 250 scan lines high.  Try 

experimenting with the height controls to see how they affect the characters. 

Changing the width of the characters will make them appear thinner or wider.  The width can be varied anywhere 

between 10 percent of normal (very thin) to 500 percent of normal (five times their normal width).  A width of 100% 

is the normal width for the character. Try experimenting with the width controls to see how they affect the 

characters. 

The italics of the text can be turned on and off.  When text is italicized, it leans to the right.  Try experimenting with 

the italics controls to see how they affect the characters. 

Cursor handles 
Cursor Handles are points on the cursor that allow you to click and drag the text around the screen.  These handles 

can be used to move and size the text.  The Cursor Handle Button is used to turn the Cursor Handles on and off. 

Turn the cursor handles on by pressing the Cursor Handle Button.  Notice that six small boxes appear around 

cursor.  Each of these small boxes is a handle.  You can move the selected text by clicking on the handle in the lower 

left corner and dragging the mouse.  Each time you pause the mouse, the text will be redrawn at the new position.  If 

you only want to move the text horizontally (without affecting the baseline alignment) you can use the handle on the 

left side of the cursor.  If you accidentally move the mouse vertically while dragging this handle, the text will not 

move vertically.  Using the handle on the bottom of the cursor will only move the text vertically, it will not allow it to 

move horizontally. 

 

Use the handle at the top of the cursor to adjust the height of the characters.  When you change the size of the cursor 

by dragging this handle, the height of the text will be changed to match the cursor size.  The relative size of each 

selected character will be maintained. 

Use the handle on the right side of the cursor to adjust the width of the text.  Dragging this handle left or right will 

change the relative width of each character that is selected.  When you change the width of the cursor by dragging 

this handle, the relative width will be adjusted to fit within the new cursor size. 

Dragging the handle on the upper right corner of the cursor will adjust both the height and width of the text. 

When you are through using the cursor handles, and you no longer want them to be displayed, press the Cursor 
Handle Button again to turn the handles off. 

Typefaces 
The typeface selection box shows the current typeface.  If you open this box up by pressing the down arrow on the 

right hand side, all of the typefaces that are currently loaded will appear.  Click on any typeface in this list to select 

it.  When a new typeface is selected, the selected text will be redrawn with the new typeface. 

Loading New Typefaces 
MediaXtreme can load two types of typefaces, Cayman Graphics proprietary format or TrueType format.  The 

TrueType format is the most popular format and has the widest selection of typefaces. You can load up to 10 
typefaces for each project.  When you use typefaces on a page, the system keeps track of which typefaces are needed 

to display the page.  If the loaded typefaces do not match the typefaces needed by the page, the correct typefaces are 

automatically loaded. 
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To load new typefaces press the “Add New Typefaces” button.  When this is done the Load New Typefaces 
window will appear as shown 

below.  

Load New Typefaces dialog box 
The typefaces that are currently loaded are listed on the right hand side of this window.  The typefaces that are 

available to be loaded (in the current directory) are listed on the left hand side.  The current directory is displayed 

in the center. 

Select the typeface format (TrueType or Cayman Graphics) that you want to load.  All of the typefaces in the current 

directory of the selected format will appear on the left side under “Available Typefaces”.  If the typefaces are 
TrueType, the full name of the typeface is shown in the actual typeface (for example, the name Helvetica will 
appear in the Helvetica typeface, the name Times New Roman will appear in the Times New Roman typeface).  
You can use this feature to preview the typefaces without the need to load them first.  To get a better look at a 

typeface, click on it in this list.  A larger sample of this typeface will appear. 

If the desired typeface is not in the current directory, select the proper directory.  Your system typefaces are usually 

stored in the “C:\WINDOWS\SYSTEM” or “C:\WINDOWS\FONTS” directory\folder. 

 

 
The typefaces do not need to be installed on your system.  You can load typefaces directly from a CD-Rom or even 

the internet.  When you load a TrueType typeface, a copy of it is made on your hard drive.  You can then remove the 

CD-Rom and the program will still be able to find the typefaces when it needs them. 

To load a new typeface, select the position that you want to load it into in the “Loaded Typefaces” list, select the 
typeface to load in that position from the “Available Typefaces” list, then press the load button.  The new typeface 
will appear in the “Loaded Typefaces” list and the next position in the “Loaded Typefaces” list will be selected.  
The typeface may also be loaded by double-clicking on it in the “Available Typefaces” list.   
When you have finished loading typefaces, press the “Done” button and the Load New Typefaces window will 
disappear.  Notice that the new typefaces now appear in the Typeface Selection Box. 
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Scope Selection  
Now that we have the basics of character attributes down, let’s try something a little more advanced.  Create a new 

page.  Set the character Height to 24 scan lines, the Width to 100 percent, turn off the italics. Select a clean/easy to 

read typeface such as Boston Black, Futurist, or Bassett Bold.  Now type the following three lines of text: 

The quick Brown Fox 

jumped over the 

lazy dogs back. 

 
Place the cursor on the M in the word jumped and select a different typeface.  Notice that only the character under 

the cursor changed.  If the toolbar is visible (above the title compose window) you’ll see a selection box with the 

words “Selected Text”.  This is called the “Scope Selection Box.”  This selection box is used to determine how 
much text the Text Style changes will affect.  If the toolbar is not visible, display it by selecting the “Display 
Toolbar” command from the “View” menu.  Open this box by pressing the down arrow and the following options 
will appear: 

• Selected Text 

• to End of Word 

• Entire Word 

• to End of Row 

• Entire Row 

• to End of Page 

• Entire Page 

 
Change this selection to “to End of Word”, then turn the italics on.  Notice that every character from the M to the 
end of the word is italicized.  Go back to the toolbar and change the selection to “Entire Word”.  Increase the 
height to 48 scan lines.  Notice that the height of the entire word changed.  Now select the “to End of Row” entry 
from the scope selection box and set the width to 50 percent.  Notice that all text from the cursor position (the M in 

jump) to the end of the row changed its’ width. 

Set scope to “Entire Row” and selected a new typeface.  Every character on the row is now drawn with the new 
typeface.  Select “to End of Page” from the scope selection box and set the height to 60 scan lines.  Every 
character from the cursor position to the end of the row, and every character on every row after the cursor changed 

to the new height.  Now select “Entire Page” as the scope and select a new typeface.  Notice that every character 
on the page changed to the new typeface. 

When “Selected Text” is chosen, the changes are applied to the character or group of characters that are selected 
by the cursor.  To select multiple characters, move the mouse to the first character to select, hold down the left 

mouse button, and drag the mouse to the last character to select.  Dragging the mouse will not select text that is on 

more than one row unless the <Shift> key is held down while the mouse is being dragged. 

Row Spacing (Leading) 
When we increased the size of the text, the rows of text overlapped each other.  Sometimes we want this effect, other 

times we don’t.  If  you want to adjust the row spacing to match the text, press the “Reset Row Spacing” button 
in the “Shortcut buttons” window (to the right of the title compose window).  This will adjust the row spacing 
(leading) so that the rows don’t overlap. 

With “Entire Page” still selected as the scope, set the Height to 24 scan lines and turn the italics off.  Now there is 
too much space between the rows.  Press the “Reset Row Spacing” button again and the excess row spacing 
(leading) will be removed. 

Edge Type 
The Edge Type is controlled by a group of five buttons.  These buttons are called radio buttons because only one 

button can be selected at the time (just like buttons on the car radio).  Pressing one button will deselect  the others.   

These buttons are used to select the edge type and to indicate the current edge type.  The edge types that can be 

selected  are as follows: 
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 No Edge  

Shows just the characters without any edge. 

 

  Full Surround Border 

Displays the characters with a border around them.  The border has equal depth on all sides of the character.  The 

depth of the border is set by the Depth controls. 

  Extruded Shadow 

Extruded Shadows appear connected to the character.  This gives the characters sort of a three-dimensional look.  

The direction of the shadow is determined by the Direction controls, and the depth is set by the Depth controls. 

  Highlighted Shadow 

A Highlighted Shadow is very similar to an extruded shadow.  However a fine border appears to highlight the 

character.  The direction of the shadow is determined by the Direction controls, and the depth of the shadow is set 
by the Depth controls. 

  Offset Shadow 

An Offset Shadow is separated from the character.  This makes it appear as though the character is above the 

background and is casting a shadow on it.  The direction of the shadow is determined by the Direction controls, any 
offset of the shadow is set by the Depth controls. 
Pressing the appropriate button selects the edge type, that button then appears depressed to indicate the current 

edge type. 

Edge Direction 
The direction of the extruded shadow, highlight shadow, and offset shadows can be controlled.  The direction is 

controlled by the direction control group shown below. 

 

 
 
There are eight buttons around the outside of this group.  Each button represents one of the eight possible directions 

(Upper Left, Up, Upper Right, Right, Lower Right, Down, Lower Left, and Left).  Pressing one of these buttons will 

select the corresponding Shadow Direction.  When the direction is selected, the button appears depressed to 

indicate the current direction. 

There is also an button/indicator in the middle of the Direction Selection Buttons.  This also indicates the current 
shadow direction.  Pressing this button will advance the shadow direction clockwise to the next direction. 

Edge Depth 
The depth of the edge is a numerical parameter that can be varied from 0 to 99 pixels.  An edge depth of zero will 

not be seen unless you make the edge blurrier than the character.  Setting the edge depth to 99 scan lines will make 

an extremely deep edge that may slow down the drawing of the characters.  If you want a really deep edge like this, I 

suggest that you compose the page using a smaller edge first.  This lets you compose the page without being slowed 

down too much.  After the text is typed, you can make the edges as deep as you want.  The edge depth will not have 

any effect on the edge if the Edge Type is No Edge. 
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The numerical controls in this group work just like the numerical controls for the Height and Width.   

Edge Blur 
The amount of blur on the edges can be changed by the controls in this numerical control group.  A Blur setting of 2 

gives a crisp sharp edge, a blur setting of 12 gives you a fuzzy edge. 

 

Text Colors 
Select the “Colors” Tab in the Control Tab Window to adjust the Text Colors.  This will display the Colors 
Control Window (shown below). 

 

 
 
The Colors Control Window has three main sections.  The first section (on the left) is used to select which 

component of the text (character, shadow 1, edge, and shadow 2) to change the color of.  The next section is a group 

of buttons used to select the method of choosing a color (color picker, color sliders, color palette, color gradient, or 

textures). The last section has the controls used in choosing a color.  These controls change based on the method of 

choosing a color that you have selected.   

Text Component 
The component group of controls contains four buttons for selecting which component of the text to change the color 

of, (character, edge, or shadows).  To change the character color, press the “Character” button.  To change the 
color of the edge, press the “Edge” button.  And so on.  When a new text component is selected, the color indicator 
box in the lower left corner of this group is changed to display the current color.  The color indicator box displays 

the current color as it is being modified. 

The component section of the Colors Control Window has an indicator to show the current color of each text 

component.  These boxes display the text components in the same order that they will appear on the screen.  The 

front box of this indicator shows the current Character color.  The box behind it (that is offset down and to the right 
of it), shows the current Shadow 1 color.  The box that is behind to both the Character and Shadow 1 indicators, 
displays the current Edge color.  The box behind and offset down to the right of the Edge indicator, displays the 
current Shadow 2 color. 
If you click on any of these indicators, the component that it represents will be selected.  The appropriate component 

selection button will appear depressed to indicate the current component.  The color indicator box will also be 

changed to the color of the selected component. 

 

Color selection methods 
There are five different methods of selecting a color.  These methods are as follows: 

• Color Picker 
The Color Picker lets you select the color using a visual approach. 

• Color Sliders 
The Color Sliders lets you select the color using a numerical approach. 

• Color Palette 
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The Color Palette lets you select a color from a palette of 64 preset colors. 

• Color Gradient 
A color can be selected from a group of 64 user defined color gradients.  This may be either a linear gradient with 

up to 16 color points that can be rotated up to 90 degrees in either direction.  It can also be an area gradient that 

can have four or five color points defined. 

• Color Texture 
A Color Texture can be selected from any of the 4 textures that are currently loaded. 

Before we begin experimenting with changing colors of the text, we should have some text that uses the edge and 

both of the shadows.  Let’s open the “Shadows” page (if it isn’t already open) that we created earlier.  Drag 
mouse across the entire word to select all of the characters.  We are now ready to play with the colors. 

Color Picker 
Press the “Picker” button to display the color picker controls.  The color picker controls are shown below. 

 

 
 
The top and bottom of each character component can each be set to different colors.  There are two boxes to select 

whether we want to change the top color, the bottom color, or both.  If the top and bottom colors are different, the 

text will be drawn with a smooth color spread between the two colors. 

 

Below these check boxes is an Illegal Color Indicator.  If the selected color exceeds NTSC or PAL limitations, this 
box will appear red to indicate that you have selected an illegal color.  Otherwise this box will appear green. 

Below the illegal color indicator is the “Pick Color From Screen” button.  Pressing this button will change the 
appearance of the mouse to look like an eye dropper.  Move the mouse to position on-screen that you want to copy 

the color of, press the left mouse button and the color under the mouse will be selected. 

To the right of these controls is the Hue Picker.  This lets you select the hue (red, green, blue, etc.) of the color.  
Place the mouse over this control, and press the left mouse button to select the desired hue.  When the new hue is 

selected, the text will be redrawn with the new color, and the Color Picker Area (to the right of the Hue Picker) 
will also be drawn with the new hue. 

Once the Hue is selected you can now pick the color.  Place the mouse over the Color Picker Area and press left 
mouse button.  This will select the color under the mouse.  If you hold down the left mouse button while you move 

the mouse, the text will be redrawn with new color each time you select a new color by moving the mouse. 

You can also control the Transparency of the color.  The transparency setting can make the color fully opaque, 
semi-transparent, or fully transparent.  When a color is semi-transparent, the text component is drawn as tinted over 

whatever is behind it.  When the color is fully transparent, it can’t even be seen on the screen.  Setting the 

transparency level to 0 makes the object fully opaque.  Setting the level to full (255) makes the object fully 

transparent.  Any value in between makes a color that is semi-transparent. 

There are a variety of ways to change the Transparency level.  Pressing the increase button to the right of the 
transparency number box can increase the level.  If you hold this button down the level will continue to increase 

until you release the button.  To decrease this value, press the decrease button.  Holding down this button will 

continue to decrease the value until it is released.  If you move the mouse over the transparency number box, then 

press and hold down the left mouse button, you can change the value by moving the mouse.  Moving the mouse up or 

to the right will increase the value.  Moving the mouse down or to the left will decrease the value.  When you have 

selected the desired value, release the left mouse button. 
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The value of the transparency level can be entered directly.  Do this by double-clicking the transparency number 

box (this will highlight all of the digits in the number), type in the new value and press the enter key. 

 

The color can be also mixed with background video.  Setting the video level to a value of zero makes the object the 

selected color.  Setting the video level to full (255) draws the object with background video.  Any value in between 

makes the object appear as background video that is tinted by the selected color.  For some very interesting effects, 

try blending colors, background video, and transparency over a background graphic image. 

The background video level can be adjusted in the same way as the transparency level. 

Color Sliders 
Press the “Sliders” button to display the Color Slider controls. The Color Slider controls are shown below. 

 

 
 
The top and bottom of each character component can be set to different colors.  There are two check boxes to select 

whether we want to change the Top Color, the Bottom Color, or both the top and bottom colors.  If the top and 
bottom colors are different, the text will be drawn with a smooth Color Spread between the two colors. 
Below these check boxes is the Illegal Color Indicator.  If the selected color exceeds the NTSC or PAL limitations, 
this box will appear red to indicate that you have selected an illegal color.  Otherwise this box will appear green. 

MediaCreator has two (2) numerical systems for defining colors.  They are RGB (Red, Green, Blue) and HLS (Hue, 
Luminance, Saturation).  Both of these systems are used to define the same thing (like yards and meters).  Adjusting 

one will automatically change the other.  You can select which method to use by pressing either the RGB or HLS 
button. You can switch back and forth between the 2 color systems at any time just by pressing the appropriate 

button. 

The RGB and HLS values can be adjusted by dragging the sliders, or by double-clicking the number box and 
entering the new value with the keyboard.   

 

Color Palette 
Press the “Palette” button to display the preset color palette.  The Color Palette is shown below. 
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The preset Color Palette can hold 64 preset colors.  These preset colors are displayed in this window.  Not all of the 

preset colors can be displayed at one time, so there is a scroll bar on the right hand side of the color palette entries.  

Use this scroll bar to scroll through all of the preset colors. 

The top and bottom of each character component can be set to different colors.  There are two check boxes to select 

whether we want to change the Top Color, the Bottom Color, or both the top and bottom colors.  If the top and 
bottom colors are different, the text will be drawn with a smooth Color Spread between the two colors.  
Below these two check boxes is the Illegal Color indicator.  If the selected color exceeds the NTSC or PAL 
limitations, this box will appear red to indicate that you have selected an illegal color.  Otherwise this box will 

appear green.  

To select a color from the preset color palette, position the mouse over the desired color and click the left mouse 

button.  You can change a color in the preset Color Palette by double clicking the entry that you want to change.  
For more information about modifying the preset Color Palette, see this section “Modifying the Color Palette” in 
chapter 10. 

This window also has a button labeled “Background Video”.  Pressing this button will set the color so that the text 
will be drawn with background video. 

Color Gradients 
Press the “Gradient” button to display the color gradients.  The Color Gradients selection window is shown 
below. 

 

 
 
64 color gradients can be loaded into the system at one time.  The Color Gradients that are currently set are 

displayed in this window.  Not all of the color gradients can be displayed at one time, so there is a scroll bar on the 

right hand side of the Color Gradient entries.  Use this scroll bar to scroll through all of the color gradients that are 

currently set for the project. 

To select a color gradient, position the mouse over the desired gradient and click the left mouse button.  The text 

will then be drawn with the selected color gradient.  You can edit a Color Gradient, or build a new one, with the 

gradient builder.  To do this, double-click the Color Gradient that you want to modify.  For more information about 

using the gradient builder, see the section “Building Color Gradients” in chapter 10. 

Color Textures 
Press the “Textures” button to display the Color Textures selection window.  The Color Textures selection 
window is shown below. 
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four (4) full Color Textures can be loaded into the system at one time.  The Color Textures that are currently loaded 

are displayed in this window.  The Textures are displayed large enough so that you can easily see what the texture 

looks like.  Not all 4 textures can be displayed in this window at one time, so there is a scroll bar on the right hand 

side of the textures.  Use this scroll bar to scroll through all of the textures that are currently loaded. 

 

To select a Color Texture, position the mouse over the desired texture and click the left mouse button.  The text will 

then be drawn with the selected texture.  You can load a new texture by a double-clicking on the one that you want 

to replace.  When this is done you will be asked to specify which graphic image you want to load as a texture.  For 

more information about loading graphic images as Color Textures, see the section “Loading Textures” in chapter 
10. 

Grabbing and Applying Attributes 
When you enter new text it is entered with the Current Text Attributes.  The text attributes specify how the characters 

and edges will appear.  The Current Text Attributes are the attributes displayed in the Text and Colors control tab 
windows. These include the following: 

• Typeface 

• Character Size 

• Italics. 

• Edge Blur 

• Edge Style (type, depth, direction) 

• Colors (character and edge) 

 
When you overwrite text, the text keeps the attributes of the text that you are overwriting.  If you would like to apply 

the Current Text Attributes to text that is already on the page, use the “Apply Text Attributes” command.  Select 
the text that you want to change the attributes of, and press the “Apply Text Attributes” button in the Shortcut 
Buttons window. 
If you want to grab the text attributes from text that is on the page, press the “Grab Text Attributes” button in the 
Shortcut Buttons window.  This will make the text attributes of the character under the cursor, the Current Text 
Attributes.  The new character attributes will then be displayed in the Text and Colors control tab windows. 

Text Style Gallery 
The “Text Style Gallery” window is used to hold preset text styles.  This is the window on the right side of your 
screen with all of the different type of “A’s” in it.  The Text Style Gallery is designed to give you quick access to 
text styles that you will use frequently throughout the project.  You can save 64 different preset text styles in the Text 

Style Gallery.  However, you are not limited to just these 64 styles. 

Before we begin, create a new page by pressing the “New Page” button on the toolbar.  The program will warn 
you that you are about to erase the current page.  Since we don’t have a page that is really worth saving, press the 

“Yes” button.  You now have a new blank page to work with. 
To enter text using one of the preset styles, select the desired text style (by clicking on it) and start typing.  Any text 

that is entered will appear with the selected text style.  To select a different preset text style, click on it and start 

typing again. 

Select a text style that looks interesting and type “This is my first preset style”.  Select another preset style and 
type “This is another one”. 
To change the style of text that is already on the screen, select the text, then click on the style that you want to set it 

to.  Move the cursor to the first character and select another style from the style gallery.  Now, move the cursor to 

the next character and select another style.  Continue to do this for every character of the first two words of the 

page. 

Select the word “first” by moving the mouse to the “f”, press the left mouse button, and drag the mouse over to the 
“t” until the entire word is selected.  Then select another text style.  Notice that the entire word is changed. 

Select the Character tab in the Control Tabs Window and adjust the Height of the word “first”.  Even though the 
character style was set using a preset style, you can still modify the style of the text.  So, if you have a text style that 
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is almost what you want, go ahead and select it, then modify the attributes of the text you just changed the style of, 

doing this will not affect the preset style in the style gallery. 

You can change the preset text styles.  Create a character on the page that has the style that you want to use as a 

preset, place the cursor on it, and move the mouse pointer to the entry in the Text Style Gallery that you want to 
set to this style, and press the right mouse button.  A pop-up menu will appear.  Select the “Set Style” command.  
The text style of the cursor character will be copied to the style gallery. 

There are too many preset text styles to be shown at one time in the text style gallery.  You can use the scroll bar to 

scroll through the preset text styles.  I like to group styles that are used together, near each other in the Text Style 

Gallery. 

Save this page to the disk by pressing the “Save Page” button on the toolbar.  Give the page the name 
“STYLES” and press the “Save” button.  You should see its thumbnail in the Xtreme Pages Manger window. 

 

 

 

 

 

Moving Text 
 
Once the text has been entered, it can be moved around and positioned.  This can be done either automatically or 

manually.  Automatic positioning of pages consists of word wrapping, word unwrapping, centering the text between 

the margins, justifying the text to the margins, or removing excess row spacing from between the rows. 

Manual positioning of the text allows you to move the text to nearly any position on the screen. 

To do automatic text positioning, use the “Positioning Controls” (shown below). You can display these controls by 
selecting the “Positioning” tab in the Control Tab Window. 

 

 
 

Word wrapping and Unwrapping 
Let’s start with a fresh page by pressing the “New Page” button on  the toolbar.  A warning may appear telling 
you that the current page is going to be erased.  If this happens press the “Yes” button.  You now have a new page 
to work with. 

Set the character height to 48 scan lines, and the character width to 100%.  Now enter the following text without 

pressing the <Enter> key “This is going to make my job so much easier”.  Notice that when you got to the 
right side of the screen, the cursor automatically went to the beginning of the next row. 

Some of the words extend beyond the right margins.  There are two common methods of fixing this.  The first method 

is to make the text smaller so that it will fit.  The other method is to wrap the words that extend beyond the margin to 

the next row.  Since this section deals with word wrapping and unwrapping, let’s try wrapping the words. 



MX Series                                                     Media Creator 

 

 

Keywest Technology 
14563 W. 96th Terrace 

Lenexa, Kansas  66215    

800.331.2019 

www.keywesttechnology.com 

40 

 

The “Word Wrap/Unwrap” section of the “Positioning Controls Window” has four buttons.  These buttons are 
as follows: 

 

 

Wrap One Word 

 

 

Wrap All Words 

 

 

Unwrap One Word 

 

 

Unwrap All Words 

 
Word Wrap checks to see if the last word of the row extends beyond the right margin.  If it does, the word is moved 

to the beginning of the next row.  Word Unwrap checks to see if the first word of the next row will fit on the current 

row.  If it will, the word gets moved up to the row above. 

Move the cursor to the home position by pressing the <Home> key twice.  Press the “Wrap One Word” button (in 
the positioning controls window).  If the last word of the cursor row extends beyond the right margin, it gets moved 

to the next row. 

If there is a word that needs to be wrapped, one word gets wrapped to the next row each time you press this button.  

If there is not a word that needs to the wrapped, pressing this button will move the cursor to the beginning of the 

next row.  Press the “Wrap One Word” button until all words that need it are wrapped to the next row and the 
cursor moves to the next row.  You could continue to wrap the entire page this way, but there is an easier way to do 

it.  Press the “Wrap All Words” button.  All of the words on the page that need to be word wrapped are moved to 
the next row. 

Select all of the text on the page by selecting “Entire Page” in the scope selection box on the toolbar.  Decrease 
the height of the text to 32 scan lines using any method that you prefer.  The rows got narrower so that you can now 

fit more text on them. 

Move the cursor back to the home position by pressing the <Home> key twice.  Press the “Unwrap One Word” 
button.  The first word of the next row should move up to the end of the cursor row if there’s room for it.  Press the 

“Unwrap All Words” button.  Every word on the page will unwrap to fill in the excess space at the end of each 
row. 

Row spacing (Leading) 
Notice that when you decreased the height of the characters that the height of the rows did not automatically get 

smaller.  The rows now seem to be spaced too far apart.  To set the row to the height that they should be, press the 

“Reset Row Spacing” button in the shortcut buttons window.  The height of each row will automatically adjust to 
what it should be for the height of the tallest character on the row. 

You can have more control over the rows spacing (leading) with the “Row Spacing” controls.  Display these 
controls (shown below) by selecting the “Row Spacing” tab in the control tab window. 
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These controls are used to increase/decrease the spacing between the rows.  The row spacing can be increased by 

pressing the “More” buttons.  The row spacing can be decreased by pressing the “Less” buttons.  To set the row 
spacing back to what it should be (based on the text on the row) press the “Set Default Row Spacing” button. 

The buttons in the “Change Row Spacing of” section of this window are used to select which row(s) we are going 
to change the row spacing of. 

• Cursor Row 

Changes the row spacing of the row that the cursor is on. 

• Entire Page 

Changes the row spacing of every row on the page. 

Fine Positioning Text 
Individual characters, words, rows, and the entire page can be fine positioned in single pixel/scan line increments.  

Characters can be moved to any position on the row and can be made to completely overlap each other.  Smaller 

characters can be positioned inside of larger characters.  Rows can even be positioned to allow text to overlap the 

text of other rows. 

There are three ways to fine position text around screen.  One method is to use the cursor handles.  Another method 

is to drag the text by moving the mouse while holding down the right mouse button.  The final method is to use the 

fine positioning buttons in the positioning control tab window. 

To use the cursor handles, select the Text tab in the control tab window and turn the cursor handles on by pressing 
the “Cursor Handles” button.  Little rectangles will appear around the cursor.  These are the cursor handles.  The 
handle in the lower left hand corner will move the text both horizontally and vertically.  The handle on the left side 

of the mouse will move the text horizontally only.  Any accidental vertical movement of the mouse will not move the 

text vertically.  The handle on the bottom of the cursor will only move the text vertically.  Accidental horizontal 

movement of the mouse will not move the text horizontally. 

To move text with these handles, select the text to move by dragging the mouse over the desired text.  Position the 

mouse over the handle that you want to use and the cursor will change to arrows that show which direction the text 

can be moved.  Press and hold down the left button of the mouse, then move the mouse.  The text will follow the 

mouse until you release the left mouse button. 

Once you are through moving the text, you can turn off the cursor handles by pressing the “Cursor Handles” 
button again. 

You can quickly move the text (both horizontal and vertical) without turning on the cursor handles.  To do this select 

the text that you want to move and press and hold down the right hand button of the mouse.  As you move the mouse, 

the text will follow it until you release the right mouse button. 

To use the fine positioning buttons to move the text, display the Fine Positioning Buttons by pressing the 
“Positioning” tab in the control tab window.  This will display the Positioning Controls Window as shown below. 
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Use these buttons to do fine incremental positioning of text.  The single arrow buttons will move the selected text one 

pixel each time you press it.  The double arrow buttons move the selected text in bigger steps. 

The “Reset Text Position” button will restore the text to its original (before it was moved) position. 

Centering and Justifying Text 
The Positioning Tab Window has 8 types of centering and justifying controls.  These are: 

 

Left Justify 
Notice how all of the lines are lined up with the left margin. 

 

Right Justify 
Notice how all of the lines are lined up with the right margin. 

 

Horizontal Centering 
Notice how all of the lines are centered between the left and right margins. 

 

Justify to Left and Right Margins 
Notice how all of lines are lined up with both the left and right margins. 

 

Vertical Centering 
The text is adjusted vertically to position it in the center of the screen. 

 

Center Horizontally and Vertically 
The text is adjusted horizontally and vertically to position it in the center of the screen. 

 

Top Justify 
The text is adjusted vertically so that the top row is placed at the top margin. 

 

Bottom Justify 
The text is adjusted vertically so that the bottom row is placed at the bottom margin. 

 
The “Row” section of the “Positioning Controls Window” (shown below) has four buttons.   
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These buttons are used to control individual rows of text.  Each row can be centered horizontally or justified to the 

left margin, right margin, or both margins at the same time. 

To center a row, place the cursor on the row that you want to center and press the “Horizontal Centering” button.  
The row is now centered horizontally between the left and right margins. 

To justify the row to the right margin, press the “Right Justify” button in the “Row” section of the “Positioning 
Controls Window”.  This moves the text to the right so that it is aligned to the right margin.  Press the “Left 
Justify” button in the “Row” section.  The text moves to the left so that it is aligned to the left margin. 
To justify the row to both margins at the same time, press the “Justify to Left and Right Margins” button in the 
“Row” section.  The first character of the row is placed at the left margin, and the spacing between the characters 
is adjusted so that the last character of the row is aligned to the right margin. 

To perform the centering and justifying functions on all of the rows of text on the page, use the corresponding 

buttons in the “Page” section of the “Positioning Controls Window” (shown below).   

 

 
 

Try pressing the “Horizontal Centering”, “Right Justify”, “Left Justify”, and “Justify to Left and Right 
Margins” buttons in the “Page” section.  Notice that the functions are now done to every row on the page. 
Press the “Center Horizontal and Vertical” button (shown here) to center the entire page both horizontally and 
vertically. 

 
 
Press the “Top Justify” button (shown here) to move the entire page to the top margin. 

 
 
Press the “Bottom Justify” button (shown here) to move the entire page to the bottom margin. 
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Press the “Vertical Centering” button (shown here) to center the page vertically between the top and bottom 
margins. 

 

Background Color Boxes 

 
The MediaCreator can display background color boxes over the background image (or external video) and behind 

the text.  Each background color box can be positioned and sized to anywhere on the screen.  The color box can be 

set to a solid color, a smooth color spread between the top and bottom of the box, a color gradient (a four or five 

point area gradient, or a linear gradient with up to 16 colors), or a full color texture.  If the background color boxes 

have a solid color, a color spread, or a color gradient, the transparency and background video levels of each color 

point can be adjusted. 

As many as 32 background color boxes can be used on each page.  Each background color box is assigned to its 

own layer.  The background color layers are always behind the text layer and in front of the background image.  The 

priority that each background color box is assigned determines how they will appear when one background color 

box overlaps another.  A background color box that has a higher priority will appear in front of color boxes that 

have lower priorities. 

To create or edit a background color box select the “Background-Colors” tab in the Control Tabs window.  The 
Background Color Box Controls (shown below) will be displayed. 

 

 
 

Creating a New Background Color Box 
To create a new background color box press the “New Background Color Box” button.  A new color box will 
appear behind the cursor row.  The background color box begins as a semi-transparent gray that is the full width of 

the screen, and the height of the cursor row. 

The cursor appears to surround the new background color box.  The cursor has six cursor handles.  Three of these 

handles (on the left and bottom of the cursor) are used to position the color box.  The other three handles (on the top 

and right of the cursor) are used to size the color box. 
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Moving and Sizing Background Color Boxes 
Use the handle at the top of the cursor to adjust the height of the color box.  Use the handle on the right side of the 

cursor to adjust the width of the color box.  Dragging the handle on the upper right corner of the cursor will adjust 

both the height and width of the color box. 

You can move the Background Color Box in any direction by clicking on the handle in the lower left corner of the 

cursor and dragging the mouse.  If you want to move the color box horizontally only (without moving it vertically) 

use the handle on the left side of the cursor.  The handle on the bottom of the cursor will move the color box 

vertically (without changing the horizontal position). 

Changing Background Color Box Color 
There are five different ways of selecting a color for the background color box.  These methods are as follows: 

• Color Picker 
The color picker lets you select the color using a visual approach. 

• Color Sliders 
The color sliders let you select a color using a numerical approach. 

• Color Palette 
The color palette lets you select a color from a palette of 64 (User Definable) preset colors. 

• Color Gradient 
A color box can be set to any of the 64 user-defined color gradients.  These may be either a linear gradient with up 

to 16 color points that can be rotated up to 90 degrees in either direction, or an area gradient that can have four or 

five color points defined. 

• Color Texture 
A color texture can be selected from any of the 4 textures that are currently loaded. 

 

Color Picker 
Press the “Picker” button to display the color picker controls.  The color picker controls are shown below. 

 

 
 
The top and bottom of each background color box can be set to different colors.  There are two boxes to select 

whether we want to change the top color, the bottom color, or both.  If the top and bottom colors are different, the 

color box will be drawn with a smooth color spread between the two colors.  The top and bottom transparency and 

background video levels can also be set independently. 

Below these check boxes is an Illegal Color Indicator.  If the selected color exceeds NTSC or PAL limitations, this 
box will appear red to indicate that you have selected an illegal color.  Otherwise this box will appear green. 

Below the Illegal Color Indicator is the “Pick Color From Screen” button.  Pressing this button will change the 
appearance of the mouse cursor to look like an eye dropper.  Move the mouse to a position on the screen that you 

want to copy the color of, press left mouse button and the color under the mouse will be selected. 

To the right of these controls is the Hue Picker.  This is used to select the hue (red, green, blue, etc.) of the color.  
Place the mouse over this control, and press the left mouse button to select the desired Hue.  When the new hue is 
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selected, the background box will be redrawn with the new color, and the Color Picker Area (to the right of the 
Hue Picker) will also be drawn with the new hue. 

Once the hue is selected you can now pick a color.  Place the mouse over the Color Picker Area and press the left 
mouse button.  This will select the color under the mouse.  If you hold down the left mouse button while you move 

the mouse around the Color Picker Area, the background color box will be redrawn with the new color each time 
you select a new color by moving the mouse. 

 

You can also control the Transparency of the color.  The Transparency setting can make the color fully opaque, 
semi-transparent, or fully transparent.  When a color is semi-transparent, the text component is drawn tinted over 

whatever is behind it.  When the color is fully transparent, it can’t even be seen on-screen.  Setting the transparency 

level to 0 makes the object fully opaque.  Setting the level to full (255) makes the object fully transparent.  Any value 

in between, makes a color that is semi-transparent. 

There are a variety of ways to change the Transparency level.  The level can be increased by pressing the increase 
button to the right of the transparency number box.  If you hold this button down, the level will continue to increase 

until you release the button.  To decrease this value, press the decrease button.  Holding down this button will 

continue to decrease the value until it is released.  If you move the mouse over the transparency number box, then 

press and hold down the left mouse button, you can change the value by moving the mouse.  Moving the mouse up or 

to the right will increase the value.  Moving the mouse down or to the left will decrease the value.  When you have 

selected the desired value, release the left mouse button. 

The value of the transparency level can be entered directly.  Do this by double-clicking the transparency number 

box (this will highlight all of the digits in the number), type in the new value and press the enter key. 

The color can be also mixed with background video.  Setting the video level to a value of 0 makes the object the 

selected color.  Setting the video level to full (255) draws the object with background video.  Any value in between 

makes the object appear as background video that is tinted by the selected color.  For some very interesting effects, 

try blending colors, background video, and transparency over a background graphic image. 

The background video level can be adjusted in the same way as the transparency level. 

Color Sliders 
Press the “Sliders” button to display the Color Slider Controls.  The Color Slider Controls are shown below. 

 

 
 

The top and bottom of each Background Color Box can be set to different colors.  There are two check boxes to 

select whether we want to change the Top Color, the Bottom Color, or both the top and bottom colors.  If the top 
and bottom colors are different, the Background Color Box will be drawn with a smooth Color Spread between the 
two colors. 

Below these check boxes is the Illegal Color Indicator.  If the selected color exceeds the NTSC or PAL limitations, 
this box will appear red to indicate that you have selected an illegal color.  Otherwise this box will appear green. 

The MediaXtreme has two (2) numerical systems for defining colors.  They are RGB (Red, Green, Blue) and HLS 
(Hue, Luminance, Saturation).  Both of these systems are used to define the same thing (like yards and meters).  

Adjusting one will automatically change the other.  You can select which method to use by pressing either the RGB 
or HLS button. You can switch back and forth between the 2 color systems at any time just by pressing the 
appropriate button. 
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The RGB and HLS values can be adjusted by dragging the sliders, or by double-clicking the number box and 
entering the new value with the keyboard.   

Color Palette 
Press the “Palette” button to display the color palette.  The Color Palette is shown below. 

 

 
 
The preset Color Palette can hold 64 preset colors.  These preset colors are displayed in this window.  Not all of the 

preset colors can be displayed at one time, so there is a scroll bar on the right hand side of the color palette entries.  

Use this scroll bar to scroll through all of the preset colors. 

The top and bottom of each Background Color Box can be set to different colors.  There are two check boxes to 

select whether we want to change the Top Color, the Bottom Color, or both the top and bottom colors.  If the top 
and bottom colors are different, the Background Color Box will be drawn with a smooth Color Spread between the 
two colors.  

 

Below these two check boxes is the Illegal Color indicator.  If the selected color exceeds the NTSC or PAL 
limitations, this box will appear red to indicate that you have selected an illegal color.  Otherwise this box will 

appear green.  

To select a color from the preset color palette, position the mouse over the desired color and click the left mouse 

button.  You can change a color in the preset Color Palette by double clicking the entry that you want to change.  
For more information about modifying the preset Color Palette, see the section “Modifying the Color Palette” in 
chapter 10. 

This window also has a button labeled “Background Video”.  Pressing this button will set the color so that the 
Background Color Box will be drawn with background video. 

Color Gradients 
Press the “Gradient” button to display the color gradient selection window.  The Color Gradient selection window 
is shown below. 

 

 
 
64 color gradients can be defined for each project.  The Color Gradients that are currently defined for this project 

are displayed in this window.  Not all of the color gradients can be displayed in this window at one time, so there is 

a scroll bar on the right hand side of the Color Gradient entries.  Use this scroll bar to scroll through all of the 

color gradients currently set for the project. 
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To select a color gradient, position the mouse over the desired gradient and click the left mouse button.  The 

Background Color Box will then be drawn with the selected color gradient.  You can edit a Color Gradient, or build 

a new one, with the gradient builder.  To do this, double-click the Color Gradient that you want to modify.  For 

more information about using the gradient builder, see the section “Building Color Gradients” in chapter 10. 
 

Color Textures 
Press the “Textures” button to display the Color Textures selection window.  The Color Textures selection 
window is shown below. 

 

 
 
8 full Color Textures can be loaded into the system at one time.  The Color Textures that are currently loaded are 

displayed in this window.  The Textures are displayed large enough so that you can easily see what the texture looks 

like.  Not 8 textures can be displayed in this window at one time, so there is a scroll bar on the right hand side of the 

textures.  Use this scroll bar to scroll through all of the textures that are currently loaded. 

To select a Color Texture, position the mouse over the desired texture and click the left mouse button.  The 

Background Color Box will then be drawn with the selected texture.  You can load a new texture by a double-

clicking on the one that you want to replace.  When this is done you will be asked to specify which graphic image 

you want to load as a texture.  For more information about loading graphic images as Color Textures, see the 

section “Loading Textures” in Chapter 10. 

Full-Screen Background Color 
To create a background color box that covers the full-screen, press the “Full Screen Background Color” button.  
A new background color box (that is a semi transparent gray) will be created that covers the entire page. 

Selecting Background Color Box 
You can only edit one background color box at a time.  Before you can modify a background color box you need to 

select it.  The selected color box is displayed with a cursor (rectangular box) around it.  The cursor also has six 

small boxes attached to it.  These are called cursor handles, they are used to size and position the background color 

box. 

Background color boxes can be selected by clicking the mouse on the desired one.  If more than one background 

color box overlap, keep clicking the left mouse button until the one you want is selected. 

Changing Color Box Priority 
Each color background box is placed on its’ own separate layer (behind the text layer and in front of the 

background graphic image).  The priority of each background color box determines how it will appear when one 

color box is overlapped by another.  The background color boxes that have a higher priority will appear in front of 

color boxes that have a lower priority. 

The background color controls have four buttons that are used to change the priority of the background color boxes.  

These buttons allow you to move the background color boxes in front of, or behind other color boxes when they 

overlap.  These buttons are shown below. 
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Press this button to move the current background color box to the highest 

priority.  When this is done it will appear in front of all other background 

color boxes. 

 

Press this button to increase the priority of the current background color 

box by one.  This will place the color box in front of the color box that 

had the next higher level of priority (if they overlap). 

 

Press this button to decrease the priority of the current background color 

box by one.  This will place the color box behind the color box that had 

the next lower level of priority (if they overlap). 

 

Press this button to move the current background color box to the lowest 

priority.  When this is done it will appear behind all of the other 

background color of boxes. 

 

Deleting a Background Color Box 
To remove a background color box from the page, select the background color box that you want to delete by 

positioning the mouse over it and clicking the left mouse button.  Once it is selected, press the “Delete 
Background Color Box” button.  This will delete the current background color box. 

Chapter 8 Background Images 

 
The program can display either a graphic image or a background video source (provided your system is capable of 

overlying titles over video) behind the text.  The background graphic can be in any of the following graphic formats: 

• Windows bitmap (BMP) 

• TIFF 

• Targa (TGA) 

• PCX 

• GIF 

• JPEG 

 
These are standard graphic formats that can be generated by many third party software packages.  If no background 

graphic image is selected, the text will be overlaid over the background video source (if your system is capable of 

this). 

A background graphic is displayed centered on the screen in its original size.  When the graphic is displayed with its 

original size, it may or may not fill the entire screen. 

To change the background image, select the “Background - Image” tab In the Control Tabs window.  The 
Background Image Controls (shown below) will be displayed. 
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No Graphic (Background Video) 
Special hardware or software is required to overlay the pages over video.  Some systems are not capable of this.  If 

your system is not capable of overlaying on video, the background will be displayed as black. 

To overlay the title over background video, press the “No Graphic (Background Video)” button.  Any 
background graphic that may have been displayed will disappear and the text will be displayed over the background 

video. 

Select New Background Graphic 
To load a graphic, press the “ Select New Background Graphic “ button.  A window will appear asking you to 
Select the Background Graphic.  Select the graphic image that you want to load as a background and press the 

“Open” button.  The selected graphic will be loaded. 
When you load a background graphic, the graphic may be smaller than the screen, the same size as the screen, or 

larger than the screen.  If the graphic is smaller than the screen, it will be centered on the screen.  If the graphic is 

the same size as the screen, it will be displayed as a full-screen image.  If the graphic is larger than the screen, the 

center portion of the graphic will displayed.  The edges of the graphic will not be displayed. 

 

Modes, Settings, and Adjustments 

User Preferences 
The “ Set User Preferences” dialog box is used to set preferences that may vary from one user to another.  To 
change the user preferences select the “User Preferences” command from the “Settings” menu.  When this is 
done the “Set User Preferences” dialog box (such as the one shown below) will appear. 

 

 
 
The set user preferences dialog box is made up of the following controls. 

Automatic Page Save mode Used to select the Automatic Page Save mode. 

Typeface/Logo/Texture Memory Used to set how much memory to use for the 
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setting Typeface, Logos, and Textures buffer. 

Other Preferences Other preferences that are unique to the type of 

hardware you are running the program with. 

 

Automatic Page Save Mode 
The program can only have one page open at a time.  When you open a new page, the old page (or any changes 

made to it) will be discarded unless it is saved to disk.  When you open a new page, or exit the program, the current 

page can automatically be saved to disk if it was changed. 

• Always Automatically Save 
This setting will automatically save the page to disk (overwriting the original) without prompting you.  Use this 

setting with caution.  Any changes you make to the page will be saved to disk.  You don’t have the option of 

changing your mind. 

• Always Ask First 
This setting will ask your permission before saving the page to disk.  If you have not modified the page, you will not 

be asked if you want to save it.   

 

Never Automatically Save 
This setting will never automatically save the page.  The program will not display the “Automatically Save 
Pages” window when you open a new page. 

Typeface/Logo/Texture Memory Setting 
When the program starts, it allocates a block of memory that is used to hold Typefaces.  This memory is also used to 

cache data that is needed temporarily when composing pages.  If you allocate more memory for this, you will be 

able to load bigger Typefaces.  You will also get better performance from the program, but less memory will be 

available for other applications. 

If you are getting an error message such as “Typeface/Logo/Texture Memory full” you should increase this 
value. 

Other Preferences 
This box may also have other user preference settings that are unique to the type of hardware or software you are 

running the program with.  

Setting up Tabs 
The program can set up to 16 tabs per page.  The tabs specify horizontal positions of the screen that are used to 

align columnar text.  The tab positions are stored with the page.  When a page is opened, the tab positions will be 

set to those that the page was created with. 

To add, remove, or reposition a tab, or to enable or disable the tab display, select the “Set Up Tabs” command 
from the “Settings” menu.  This will display the “Set Up Tabs” dialog box (shown below). 
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Display Tab Positions 
The Tab Display shows the positions of the tabs that are currently set.  If the tab display is enabled, vertical lines 

will appear the full height of the screen.  Each one of these vertical lines shows the position of a tab that is currently 

set.  Clicking the “Display Tab Positions” check box will toggle the state of the Tab Display.  If the Tab Display is 
on (signified by a check mark), this will turn it off. 

Markers in the set up tabs window  (below the title compose window) also shows the current tab positions.  These 

markers are displayed regardless of the “Display Tab Positions” setting.  Let’s call this window the “Tab 
Markers Window”. 
Once the tabs have been set up, they can be saved as the default tab settings in a project. 

Set a New Tab 
The Tab Markers window displays all of the tabs that are currently set.  To set a new tab, position the mouse in the 

Tab Markers window at the position that you want the new tab and click the left mouse button.  A new marker will 

appear at the mouse position to indicate the position of the new tab. 

Move a Tab 
To move (reposition) an existing tab, position the mouse over the Marker that you want to move and drag it to the 

desired position.  Any text that is on the page will be redrawn to reflect the new tab position. 

Delete a Tab 
To delete an existing tab, select the marker that you want to delete by moving the mouse over it and pressing the left 

mouse button.  The marker will turn red to indicate that it is selected.  Press the “Delete Tab” button.  The selected 
marker will be deleted. 

Safe title Margins 
When transmitting a video signal to a large number of televisions, many of those televisions will not be properly 

adjusted.  If you create a full page of text and try to view it on one of these televisions, the text may be cut off on the 

left, right, top, or bottom of the screen.  When you broadcast text, you normally want everyone to be able to read it 

(especially if you are trying to sell them a new TV). 

To solve this problem we define margins that it is safe to title within.  The margins are set by the factory to be at the 

recommended 10% height and width positions of the screen.  You can change these margin positions.  To do this 

select the “Safe title Margins” command from the “Settings” menu.  When this is done the safe title margins 
dialog box (shown below) will appear.   

 
 
Use the “Display Safe title Margins” check box to hide or display the safe title margins on the screen.  The safe 
title margins are displayed on the screen whenever the “Safe title Margins” window is displayed, regardless of the 
state of the “Display Safe title Margins” check box. 
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If you keep your text within this box it will be in the safe title area.  Use the arrow buttons to move the safe title 

margins.  Each margin (top, bottom, left, and right) has two buttons that are used to move them. 

 

 

Moves the margin up one scan line.  

 

Moves the margin left one pixel. 

 

 

Moves the margin down one scan 

line. 
 

 

Moves the margin right one pixel. 

 
To set the margins to the recommended 10 percent height and width positions of the screen, press the “Default” 
button. 

Once the safe title margins are adjusted, press the “Done” button.  This will remove the dialog box from screen.  
The safe title settings are saved as one of the project settings. 

Lower Third Mode 
Quite often with titling an image, you want to keep the titles in the Lower Third position of the screen.  To do this, 

without needing to re-position every page, set the system to Lower Third mode.  This moves the top margin (as well 

as the page text) to the Lower Third position.  Any pages composed in this mode will appear in the Lower Third 

portion of the screen.  Centering a page in this mode will center it in the Lower Third area. 

To change the Lower Third mode select the “Lower Third Mode” command from the “Settings” menu.  If the 
system is already in Lower Third mode, the Lower Third mode will be turned off.  You can also toggle the Lower 

Third mode by holding down the <Ctrl> key while pressing the <T> key.   
The current lower third mode can be saved as one of the default project settings. 

 

Modifying the Color Palette 
To modify the color palette, the color palette must be displayed.  You can display the color palette by selecting the 

“Colors” tab in the Control Tabs Window and then pressing the “Palette” button.  Position the mouse over the 
color palette entry that you want to change and double-click the left mouse button.  When this is done the “Color 
Palette Editor” window (shown below) will be displayed. 
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The color palette editor has two methods of selecting a color.  You can use either the Color Picker or the Color 
Sliders.  The left side of this window shows a large sample of the current color selection.  To the right of the color 
sample, at the bottom of the window, is an Illegal Color Indicator.  If the selected color exceeds NTSC or PAL 
limitations, this indicator will appear red to indicate that you have selected an illegal color.  Otherwise this 

indicator will appear green. 

At the top of the screen, between the Color Sample and the Color Palette, are the Color Picker controls.  These 
controls include a “Hue Picker” and a “Color Picker Area”.  The hue picker lets you select the hue (Red, Green, 
Blue, etc.) of the color.  Place the mouse over this control, and press the left mouse button to select the desired hue.  

When the new hue is selected, the Color Sample, Color Picker Area, and the Color Sliders will be updated to 
reflect the new hue. 

Once the hue is selected you can now pick the color.  Place the mouse over the Color Picker Area and press the left 
mouse button.  This will select the color under the mouse.  If you hold down the left mouse button while the mouse is 

moved, the Color Sample and the Color Sliders will be updated to reflect the newly selected color. 
Below the Color Picker Controls and the Color Palette Display are the Color Sliders.  There are two numerical 

systems for defining colors.  These are RGB (Red, Green, Blue), and HLS (Hue, Luminance, Saturation).  Both of 

these systems are used to define the same thing (like yards and meters).  Adjusting one will automatically change the 

other.  You can use either set of sliders to adjust the color.  When you use one set of sliders to change the color, the 

other set is automatically updated to reflect the change. 

There are four ways to adjust the RGB, HLS, Transparency, and Background Video levels.  They can be adjusted by 

dragging the sliders.  They can also be adjusted by double-clicking the number box and entering the new value with 

the keyboard.  To “fine tune” the levels, use the increment and decrement buttons.  The value will be increased or 

decreased by one each time you press one of these buttons.  These buttons will auto-repeat if you hold them down.  

The values may also be changed by clicking in the number box and dragging the mouse. 

To the right of the Illegal Color Indicator is a “Transparent” button.  Pressing this button will set the transparency 
level to full (255).  This makes the color fully transparent.  Anything that you assign this color to will not be visible. 

To the right of the “Transparent” button is a “Background Video” button.  Pressing this button will set the 
background video level to full (255).  Anything that you assign this color to will be displayed using background 

video. 
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To the right of the “Background Video” button is a “Pick Color From Screen” button.  Pressing this button will 
change the mouse cursor to look like an eyedropper.  Move the mouse to the position of the screen that you want to 

copy the color of, and press the left mouse button.  The color under the mouse will be selected. 

When you have selected the desired color for the color palette entry, you can select another color to modify from the 

color palette.  When you are done modifying the color palette, press the “OK” button and the Color Palette Editor 
window will close.  

Once the color palette has been modified, the changes must be saved with the project settings.  Otherwise, they will 

revert to the old settings when the project is opened again. 

Loading Textures 
The system has 16 slots that textures can be loaded into.  When you use a texture on a page, the page keeps track of 

which textures are needed to display the page.  If the textures that are loaded do not match the textures needed by 

the page, the correct textures are automatically loaded. 

To load a new texture, the texture selection window must be displayed.  You can display the textures selection 

window by selecting the “Colors” tabs from the Control Tabs Window and then pressing the “Textures” button.  
Position the mouse over the texture entry that you want to load the new texture into and double-click the left mouse 

button.  When this is done the “Select Graphic Image to use as a Texture” window (shown below) will be 
displayed. 

 

 
 
Select the graphic image that you want to load as a texture and press the “Open” button.  The selected image will 
then be loaded as a texture. 

Building Color Gradients 
64 color gradients can be defined for each project.  To modify a color gradient, the color gradient selection window 

must be displayed.  You can display the color gradient selection window by selecting the “Colors” tab from the 
Control Tabs Window and then pressing the “Gradient” button.  Position the mouse over the gradient that you 
want to modify and double-click the left mouse button.  When this is done the color gradient builder (shown below) 

will be displayed. 
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The color gradient builder has two major sections, the Color Selection section (on the right) and the Color Point 

Placement and Selection section (on the left).  The Color Selection section is used to select the color of each point in 

the color gradient.  The Color Point Placement and Selection section is used to select which point that you want to 

change the color of, and to change the position of the color points that make up the Gradient. 

The program can create two types of color gradients, Linear Gradients and Area Gradients.  A Linear Gradient can 

have as many as 16 color points and can be rotated up to 90 degrees in either direction.  An Area Gradient can have 

either four (4) or five (5) color points.  A four-point color gradient lets you define a different color in each corner of 

the rectangle.  A five-point color gradient also lets you add a 5th color point inside the Area Gradient.  The 5th color 

point can be moved to any position inside the gradient. 

 

The color point placement and selection section has two tabs.  One to edit Area Gradients and the other to edit 

Linear Gradients.  When the color gradient builder is first opened, the tab that corresponds to the type of gradient 

that you are editing is selected.  To change the color gradient to the other type just select the other tab. 

Area Gradients 
The “Area Gradient” tab (shown below) is used to edit area color gradients. 
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The top portion of this window displays the current color gradient.  If it is a five-point color gradient, two markers 

will appear.  One above the gradient and one to the left of the gradient.  These indicate the position of the fifth point 

inside the gradient.  You can move the inside color point by dragging these markers.  You can also moved the inside 

color point by clicking at the desired position in the color gradient in this window. 

The Corners group is used to select the color point(s) of the Area Gradient that you want to change the colors of.  If 
the color gradient is a 4 Point Area Gradient, four check boxes will be displayed representing each corner of the 

gradient.  If the color gradient is a five point Area Gradient, an extra check box will appear which represents the 

inside color point.  When a color point is selected, the box is marked.  You can select more than one color point to 

be changed.  When you select a different color (in the color selection section) all of the selected points will be set to 

the new color.  

 

There are two buttons in the Spread Type Group that let you select whether this will be a 4 Point or a 5 Point color 

gradient.  If you select “ 5 point”, the positioning markers will appear.  A center check box in the corners group 
will also appear. 

The “Apply Color to Selected Corners” button will set all of the selected color points to the current color. 

 

Linear Gradients 
The Linear Gradient tab (shown below) is used to edit Linear Color Gradients. 
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The Linear Gradient tab has three main controls.  The control on the left (let’s call it the Placement Control) 

displays the current position and color of each point on the Linear Gradient.  The top control displays the current 

Linear Color Gradient.  The bottom control (let’s call it the Angle Control) is used to set the angle of the Linear 

Color Gradient. 

The Placement Control shows positions and colors of the color points that are currently set.  A marker on the left 

side of the Placement Control represents each color point.  You can use this control to add a new color point, move 

an existing color point, delete a color point, or to select a color point to change the color of.   

Set a New Color Point 
To set a new color point, position the mouse over the Placement Control where you want the new color point to be 

and press the left mouse button.  A new marker will appear at the mouse position to indicate the new color point. 

Move a Color Point 
To move (reposition) an existing color point, position the mouse over the marker that you want to move and drag it 

to the desired position. 

Delete a Color Point 
To delete an existing color point, select the marker that you want to delete by moving the mouse over it and pressing 

the left mouse button.  The marker will turn red to indicate that it is selected; all other non-selected markers will be 

blue.  Press the <Del> key on the keyboard, and the selected marker (and color point) will be deleted. 

Change the Color of a Color Point 
To change the color of a color point, select the color point that you want to change the color of, by moving the 

mouse over its’ marker and pressing the left mouse button.  The marker will turn red to indicate that it is selected.  

Use the controls in the Color Selection section (on the right hand side) of the Color Gradient Builder. 



MX Series                                                     Media Creator 

 

 

Keywest Technology 
14563 W. 96th Terrace 

Lenexa, Kansas  66215    

800.331.2019 

www.keywesttechnology.com 

59 

 

Rotating a Linear Gradient 
Use the angle control to rotate the Linear Gradient.  The angle control indicates the current rotation angle of the 

gradient with the line that is in the half circle.  If the gradient is vertical, the indicator line in the half circle will be 

vertical.  If the gradient is angled to the right, the indicator line will go off to the right, and so on.  You can rotate 

the Linear Gradient by clicking the mouse within the half circle.  You can also drag the rotation angle by dragging 

the indicator line back and forth.  As the rotation is changed the color Gradient Indicator (above the angle control) 

is redrawn to display the new angle of rotation. 

Selecting a Color for the Color Point 
Once you have selected which point(s) that you want to change the color of, use the Color Selection controls (on the 

right hand side of the Color Gradient Builder) to select the new color.  The Color Gradient Builder has three 
methods of selecting a color.  You can use the Color Picker, the Color Sliders, or the Color Palette.   

At the top of the screen, on the left-hand side of the color selection section, are the Color Picker controls.  These 

controls include a “Hue Picker” and a “Color Picker Area”.  The hue picker lets you select the hue (Red, Green, 
Blue, etc.) of the color.  Place the mouse over this control, and press the left mouse button to select the desired hue.  

When the new hue is selected, the Color Gradient, Color Picker Area, and Color Sliders will be updated to reflect 

the new hue. 

 

Once the hue is selected, you can now pick the color.  Place the mouse over the Color Picker Area and press the left 

mouse button.  This will select the color under the mouse. The Color Gradient and the Color Sliders will be updated 

to reflect the newly selected color.  If you hold down the left mouse button while the mouse is moved, the color under 

the mouse will be selected as the mouse is moved. 

To the right of the Color Picker controls is the Color Palette.  The Color Palette has 64 preset colors.  Not all of the 

preset colors can be displayed at one time, so there is a scroll bar on the right hand side of the Color Palette.  Use 

the scroll bar to scroll through all of the preset colors.  To select a color from the Preset Color Palette, position the 

mouse over the desired color and click the left mouse button.  When a color is selected from the color palette, the 

Color Gradient, Color Picker Area, and the Color Sliders will be updated to reflect the new color. 

Below the Color Picker controls and the Color Palette display are the Color Sliders.  There are two numerical 

systems for defining colors.  They are RGB (Red, Green, Blue) and HLS (Hue, Luminance, Saturation).  Both of the 

systems are used to define the same thing (like yards and meters).  Adjusting one will automatically change the 

other.  You can use either set of sliders to adjust the color.  When you use one set of sliders to change the color the 

other set is automatically updated to reflect the change. 

There are four ways to adjust the RGB, HLS, Transparency, and Background Video levels.  They can be adjusted by 

dragging sliders.  Double-clicking the number box and entering the new value with the keyboard can also adjust 

them.  To “fine-tune” the levels, use the increment and decrement buttons.  The value will be increased or decreased 

by one each time you press one of these buttons.  These buttons will auto-repeat if you hold them down.  Clicking on 

the number box and dragging the mouse may also change the values. 

This section includes an Illegal Color Indicator to warn you if the selected color exceeds NTSC or PAL limitations.  
The Illegal Color Indicator will appear red if you have selected an illegal color, otherwise it will appear green. 
To the right of the Illegal Color Indicator is a “Transparent” button.  Pressing this button will set the transparency 
level to full (255).  This makes the color fully transparent.  This portion of the color gradient will not be visible.  You 

will see what is behind it on screen. 

To the right of the “Transparent” button is a “Background Video” button. Pressing this button will set the 
Background Video level to full (255).  This portion of the color gradient will be displayed using Background Video. 

 

To the right of the “Background Video” button is a “Pick Color From Screen” button.  Pressing this button will 
change the mouse cursor to look like an eyedropper.  Move the mouse to the position of the screen that you want to 

copy the color of, and press the left mouse button.  The color under the mouse will be selected. 

Once you have finished changing the color of the selected color point(s), you can select another color point to 

change the color of. 
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Final steps 
When you are finished creating the new Color Gradient (or modifying an existing gradient) press the “OK” button 
and the Color Gradient Builder window will close.  Any changes to the color gradients must be saved with the 

project settings.  Otherwise they will revert to the old Color Gradients when the project is opened again. 

 

Exiting the MediaCreator 

 

 
When it’s time to exit the MediaXtreme, select the “Exit” command from the “File” menu.  The program will begin 

its shut down sequence.  The program can also be exited by holding down the <Alt> key while pressing <X>. 

Any page changes or settings changes that are not saved will be lost when you exit the program. 

If the page has been modified, and the “Automatically Save Pages” setting in the “User Preferences” dialog box 

requires it, the following message will appear. 

 

 
 

If you want to save the changes to the page, press the <Yes> button, otherwise press the <No> button and the 

changes will be discarded. 

 

 

 

 

 

 

 

 

 

 

 

 

Optional Components 
 

Local Internet Weather Setup and Operation Manual 
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The Local Internet Weather option allows you to display basic local weather parameters on your 

MediaXtreme Pages and Crawls (parameters listed below in variables table) without purchasing 

a full weather instrument hardware package.   

 

 

 

 

 

Setup Instructions: 

 

If not already present, connect a Keyboard, Mouse, and Local Monitor to the MX and reboot the 

player.    After the reboot and a schedule has started to play, press the ESC (Escape) key to 

access the MX desktop. 

 

Double click the LIW icon that should be on the system tray: 

 

(1) Double click on the My Computer icon on the desktop;  select MediaXtreme (C:) 

(2) Open the ‘LIW’ Folder; Double click on the LIW.exe application.  The application should 
now be open, but it will be minimized at the bottom of the screen in the taskbar.  Click 

on it to open it. 

(3) You should see the following: 

 
 

(4) Click on File and select ‘Setup Location…’ 

 
 

(5) Now you will be prompted with a series of screens to set up your Local Internet Weather. 

Operational Note:  Local Internet Weather REQUIRES the MX have a constant connection 

to the INTERNET and ports be open allowing browsing rights for the player. 
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Select ‘Next >>’ to move the next screen. 

 

 
Select the Appropriate Country.  The software Defaults to the United States.   

Select  ‘Next >>‘ when you are ready to move on. 
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Now select the corresponding State.  Select ‘Next >>’ When you are 

Ready to continue. 

 

 
Select the Airport that is closest to your location.  Press  ‘Next>>’ to  
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Continue. 

 

 
Please Verify your choice and select check the box so you will not have to go through this 

setup again.  Click on the  

‘Finished’ button when you are ready. 

 

 

 

Now that you have setup your Local Internet Weather, close the application.  Make sure the 

MediaXtreme can access the World Wide Web.  If you cannot access the Internet, Please 

contact your Network Administrator for further assistance.  Now move over to the Media 

Creator side. 

 

Operating The Local Internet Weather 
Nothing will change with the operation of the Media Creator.  The only additions are 19 new 

variables.  They are listed below: 

 

Wind Gusts US=#I0 

Wind Gusts Metric=#I1 

Wind Gusts MPH=#I2 

Wind Direction Compass=#I3 

Visibility Kilometers=#I4 

Visibility Miles=#I5 

Barometer Metric=#I6 
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Barometer US=#I7 

Temperature Celsius=#I8 

Temperature Fahrenheit=#I9 

Dew point Metric=#IA 

Dew point US=#IB 

Wind Speed MPH=#IC 

Wind Speed Knots=#ID 

Wind Gusts Knots=#IE 

Wind Direction Degrees=#IF 

Location=#IG 

 

The figure below shows you how to insert a variable.  Once you have inserted a variable you will 

only see the #I Code on the Media Creator.  When the page is displayed on the MediaXtreme it 

will be updated with the correct Weather information. 
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BACKGROUND IMAGES 

 

Thumbnail images of the included background graphics follow.  Note that not all customers will 

receive all of the shown images. 
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